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RESUMO 

 

Assim como diversas áreas do cotidiano estão utilizando a tecnologia de 
diversas formas, a medicina está cada vez mais adepta dessa informatização como 
auxilio da sua evolução e meio de facilitar atendendo diversas necessidades, sendo 
tanto ao médico em si quanto ao paciente. Essa inovação ajudará desde o 
armazenamento de dados do paciente, facilitar o diagnóstico e identificação de 
enfermidades até mesmo no auxílio do foco do tratamento e posteriormente a cura é 
enfatizada a necessidade desse casamento entre a medicina e a tecnologia. Dentre 
as diversas áreas da medicina é visto que as imagens de ultrassom são necessárias 
para o diagnóstico e análise de diversas doenças e, junto com essas imagens que já 
são provenientes de uma devida tecnologia, existem outras técnicas computacionais 
que podem ser utilizadas para facilitar a conclusão sobre a imagem em si. É nesse 
contexto que se configurou a proposta deste trabalho, a qual consistiu na 
implementação de técnicas de processamento de imagens para análise de ovários. 
Diante de várias doenças que podem ser detectadas com imagens de ultrassom, a 
escolha foi feita para os ovários policísticos, sendo utilizadas por médicos 
ginecologistas. Para que a aplicação pudesse encontrar de forma eficiente os 
resultados, foram realizados vários testes para enfim chegar a uma conclusão de 
quais seriam as técnicas de processamento utilizadas e, por fim, implementando-as 
no software utilizando o NetBeans e o ImageJ como plugin e ferramenta principal 
desse desenvolvimento. Este projeto contribuiu como uma proposta multidisciplinar, 
na qual foi constatado que essa ferramenta pode atender diversas áreas da 
medicina e sua utilização pode auxiliar de diversas formas e após a coleta dos 
resultados, foi verificado a eficiência da mesma comparado ao diagnóstico feito por 
um médico. 
 

Palavras-chave: Imagej. Técnicas de processamento de imagens. Ovário  
policístico. NetBeans. Medicina. 

 

 

 

 

 

 

 

 

 

 



ABSTRACT 

 

Like many areas of daily life are using technology in different ways, medicine 
has become increasingly adept this computerization in the support of development 
and means of facilitating meeting diverse needs, being for the doctor himself or to the 
patient. This innovation could help from the patient data storage, facilitating the 
diagnosis and identification of disease even in aid of the focus of treatment and then 
the cure is emphasized the need for this marriage between medicine and technology. 
Among the many areas of medicine is seen that ultrasound images are needed for 
the diagnosis and analysis of various diseases and, along with those images that are 
already coming from a proper technology, there are other computational techniques 
may be used to facilitate completion on the image itself. It is in this context that set up 
the purpose of this study, which consisted of the implementation of image processing 
techniques for ovarian analysis. In view of various diseases that can be detected with 
ultrasound images, the choice was made for polycystic ovaries, being used by 
gynecologists. So that the application could meet efficiently the results were 
performed several tests to finally conclude what would be the processing techniques 
used and finally, implementing them in software using NetBeans and the ImageJ 
plugin and as main tool this development. This project contributed as a 
multidisciplinary proposal, in which it was found that this tool can meet various areas 
of medicine and its use can help in many ways and after collection of the results, it 
was verified the efficiency of the same compared to the diagnosis made by a doctor. 

 

Keywords: ImageJ. Image-processing techniques. Polycystic ovary. NetBeans. 

Medicine. 
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1 INTRODUÇÃO 

 

Os computadores apresentam um grande desempenho em quase todas as 

áreas na atualidade, e são fundamentais para auxiliar a humanidade na realização 

de tarefas incríveis e processamento de informações rapidamente. Em companhia 

do intelecto humano, pode alcançar inúmeras utilizações, e adquirir os resultados 

desejados com melhor eficiência, trazendo benefícios extraordinários com o intuito 

de auxiliar a evolução em diversas áreas. 

 
A humanidade está atravessando um importante processo de mutação que 
consiste na migração de uma sociedade de produção industrial para uma 
sociedade marcada pela informação e pelo conhecimento. Informação é a 
essência de qualquer atividade humana. (SIGULEM et al., 1988). 

 

As técnicas computacionais têm apresentado uma nova dimensão para cada 

campo e podem ser empregados em diversas áreas, como engenharia, 

processamento de dados e planejamento de armazenamento, programação, redes, 

educação, bem como da saúde e da medicina. 

Segundo Sigulem et al. (1988), os computadores têm se tornado cada vez 

mais presentes na área da saúde, propiciando softwares para auxiliar os médicos 

visando uma melhor qualidade aos cuidados da saúde, ajudando os profissionais de 

diversas formas em prol de um melhor diagnóstico, avaliação e por fim, na cura das 

doenças. 

Os autores supracitados ressaltam também que é, no entanto, a contínua 

preocupação com o bem-estar do paciente e a consequente necessidade de um 

processo de decisão ideal, que coloca a Medicina em uma posição diferenciada em 

relação aos outros campos dependentes do manuseio da informação.  

O impacto da tecnologia na prática da medicina é surpreendente. As técnicas 

não invasivas de produção de imagem, como a ultrassonografia, a medicina nuclear, 

a tomografia e a ressonância magnética, alteraram sensivelmente o processo de 

diagnóstico médico. (SIGULEM et al., 1988).  

Na prática médica, a informática ajuda na coleta, no registro e na análise de 

dados; gera conhecimento sobre o conhecimento e, dessa forma, diz respeito a 

todas as áreas da medicina, da microscópica à macroscópica e da assistência 

individual à saúde coletiva. (DEGOULET; FIESCHI, 1997).  
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Se um grupo de médicos, cientistas da área de computação ou cientistas de 
outras disciplinas fosse questionado sobre o que é informática médica, não 
haveria uma resposta única. Alguns apontariam exemplos concretos, 
considerando as aplicações na área da computação médica como um 
conjunto de técnicas e ferramentas. Outros enfatizariam a tecnologia 
propriamente dita, seu progresso nos anos recentes ou as perspectivas 
futuras. Essas respostas descrevem a ponta do iceberg, posto que 
apresentam a computação médica apenas por suas aplicações e técnicas. 
(DEGOULET; FIESCHI, 1997). 

 

De acordo com Blum (1990), as aplicações do computador para área da 

saúde podem ser analisadas de acordo com as décadas em que foram instaladas. 

As primeiras discussões datam da década de 60, e buscavam reproduzir no 

ambiente hospitalar, os sistemas gerenciais adotados na área industrial e comercial.  

Segundo Domencis Junior ([199-?]), o casamento entre a medicina e a 

informática deve ser duradouro destaca a descoberta de medicamentos 

revolucionários, como a penicilina e a aspirina promoveram um importante aumento 

no tempo de vida do ser humano.  

O autor citado anteriormente destaca que a alta velocidade de descobertas 

científicas gerou uma grande quantidade de dados a serem analisados. É neste 

ponto que a informática se tornou uma aliada fundamental da medicina. Destaca 

também que a telemedicina com digitalização de dados permite contato em tempo 

real com especialistas nacionais e internacionais, que podem emitir segundas 

opiniões sobre casos mais complicados, beneficiando sobremaneira o paciente e 

evitando deslocamentos desnecessários. 

 
A utilização dos dados obtidos permite ao paciente menor exposição à 
radiação, maior rapidez na realização do exame e disponibilização imediata 
das imagens para o estudo do radiologista. Também a documentação das 
imagens em CD-ROM permite redução de custos, além de maior 
capacidade de armazenamento de exames, inclusive para comparação com 
estudos anteriores. Programas específicos navegação cirúrgica, muito 
importantes para cirurgias neurológicas, por exemplo, também exigem a 
utilização de dados de imagens digitais armazenados em CD-ROM. 
(DOMENICIS JÚNIOR, [199-?].).  

 

Visto que um diagnóstico baseado apenas na avaliação de imagens dos 

pacientes nem sempre é uma tarefa sucessiva, a ideia de utilizar o computador 

como auxílio para melhorar a interpretação desse diagnóstico é bastante significativa 

e deve ser inserida no cotidiano dos médicos e seus pacientes. 
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De acordo com as dificuldades encontradas pelos médicos e pacientes e 

quanto ao uso da informação baseada em conhecimento, afirmam que as 

necessidades dos profissionais da saúde recaem em três categorias. (HERSH, 

1996).  

a) ajuda para resolver um certo problema ou tomar uma decisão;  

b) ajuda para obter informações básicas em determinado tópico;  

c) ajuda para manter o conhecimento atualizado sobre determinado assunto. 
 

Uma das principais utilizações da tecnologia na medicina está presente na 

ultrassonografia, método que contribui auxiliando no diagnóstico médico, sendo 

principalmente utilizada na obstetrícia e ginecologia podendo auxiliar no 

monitoramento do feto antes do nascimento, e detectando doenças nos órgãos da 

paciente como a síndrome do ovário policístico. 

No caso da Síndrome do ovário policístico, após utilização do ultrassom 

realizado o médico deve avaliar as imagens em mãos, e verificar se existem cistos e, 

dependendo da quantidade, diagnosticar se existe ou não a enfermidade. Essa 

análise pode levar um tempo, e nem sempre o diagnóstico estará totalmente correto.  

As técnicas de processamento de imagens podem auxiliar na análise dessas 

imagens, e transmitir os devidos resultados de acordo com a situação da paciente. 

Isso fará com que o médico não precise avaliar essas imagens a olho nu, 

propiciando um diagnóstico mais rápido e eficaz, gerando mais tempo para cuidar do 

tratamento da doença. Uma das possíveis aplicações de técnicas de processamento 

de imagens é, por exemplo, no diagnóstico da Síndrome do Ovário Policístico.  

De acordo com Varela ([198-] década certa) a Síndrome do Ovário Policístico 

é um distúrbio endócrino complexo que afeta muitas mulheres na puberdade, assim 

como grupos em idade reprodutiva com profundos efeitos adversos, tais como a 

obesidade, infertilidade, doenças cardiovasculares e diabetes. O diagnóstico da 

doença é por meio de parâmetros clínicos, bioquímicos e de imagem.  

O principal recurso do ultrassom é encontrar a presença de ovários 

policísticos com cistos periféricos dispostos na densidade do estroma. Durante a 

avaliação do ultrassom, a partir da sobreposição dos folículos, bem como o ruído 

inerente do equipamento delinear, tornando essa aparência característica pode 

tornam-se um desafio, aumentando o tempo de diagnóstico.  
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Além disso, a interpretação poderia variar consideravelmente de um operador 

para outro, dificultando a exatidão dos resultados. 

Neste contexto um esquema automatizado de uma aplicação para a detecção 

do padrão da disposição, aparência dos cistos e arranjo de folículos é proposto para 

resolver este problema.  

A aplicação faz com que um resultado mais específico e exato seja 

encontrado em menos tempo. Podendo assim, agilizar o processo de diagnóstico e, 

posteriormente, o tratamento da doença para os pacientes. 
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2 OBJETIVOS 

 

Serão descritos os principais objetivos a serem efetuados nesse trabalho, 

explicando detalhadamente cada parte a ser executada seguidamente. 
 

2.1 OBJETIVO GERAL 

 

Desenvolver uma aplicação assistida por computador para detecção da 

morfologia dos ovários policísticos em imagens de ultrassom, utilizando técnicas de 

processamento de imagem. 
 

2.2 OBJETIVOS ESPECÍFICOS 

 

a) coletar imagens de ultrassom que contenham ovários normais e 

policísticos; 

b) desenvolver uma aplicação utilizando técnicas de processamento de 

imagens; 

c) analisar as imagens de ultrassom de ovários para detectar o número, 

tamanho e distribuição dos folículos; 

d) gerar estatísticas sobre os resultados referente a existência da presença 

ou ausência da doença; 

e) verificar a qualidade da aplicação desenvolvida, executando testes de 

desempenho, qualitativo e quantitativo verificando a eficiência da 

aplicação. 
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3 SINDROME DO OVÁRIO POLICÍSTICO (SOP) 

 

A Síndrome de Stein-Leventhal, também conhecida como síndrome dos 

ovários policísticos (SOP) é descrita por legro (2013), como um transtorno em 

mulheres, que se caracteriza por um nível elevado de hormônios masculinos 

(andrógenos) e ovulação infrequente ou ausente (anovulação). Varela ([199-?])  

ressalta que cerca de cinco por cento das mulheres são afetadas por essa síndrome 

a qual é responsável por uma proporção substancial dos casos de infertilidade 

feminina. 

 
A síndrome foi descrita pela primeira vez em 1935, quando ginecologistas 
americanos Irving F. Stein, Sr., e Michael L. Leventhal associaram a 
presença de cistos ovarianos com anovulação. Durante muitos anos, esses 
fatores foram utilizados como critérios de diagnóstico da síndrome. Mais 
tarde, percebeu-se que anovulação e um elevado nível de andrógenos, e 
não cistos ovarianos foram os critérios diagnósticos mais corretos, uma vez 
que é a combinação desses fatores que resultam de ou é sintomático das 
outras características da síndrome. Enquanto a causa da síndrome 
permanece desconhecida, a evidência sugere que a síndrome é complexa, 
envolvendo múltiplos sistemas fisiológicos. Por exemplo, a resistência à 
insulina parece desempenhar um papel central no desenvolvimento da 
doença, com os ovários apenas um dos vários órgãos que podem ser 
afetadas sendo. (LEGRO, 2013). 

 

 Segundo Varela ([199-?]), ovários normais têm um tamanho médio de 9 

centímetros cúbicos, enquanto que o ovário policístico, atinge 20 centímetros 

cúbicos. Como pode ser observado na Figura 1, os cistos presentes nos ovários são 

pequenas bolsas que contém um material líquido armazenado, e podem ser do tipo 

sintomático, que representa apenas 10% dos casos, ou assintomático.        

 

Figura 1 - Ovário Normal e Ovário Policístico 

                             Fonte: Gomes (2013). 
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O autor citado anteriormente destaca que os ovários são dois órgãos que 

estão alojados um de cada lado do útero, e são os responsáveis pela produção dos 

hormônios femininos, e também por acolher os óvulos que todas as mulheres trazem 

consigo desde que estão no ventre materno. Ele ressalta que o que se sabe é que 

aproximadamente 20% a 30% das mulheres tem tendência a desenvolver cistos nos 

ovários, isto é, pequenas bolsas que contém matéria (líquido ou semissólido), como 

mostra a Figura 2. 

 

Figura 2 -  Detalhes de Ovário normal e Ovário Policístico 

                    Fonte: Monterey Bay IV Fertility & Gynecology Center ([c2012]). 
 

Os folículos são bolsas dentro dos ovários que contêm óvulos. Normalmente, 

um ou mais óvulos são liberados durante cada ciclo menstrual, o mesmo é chamado 

de ovulação. Na síndrome de ovário policístico, os óvulos nesses folículos não 

amadurecem nem são liberados dos ovários. Em vez disso, eles podem formar 

cistos muito pequenos no ovário, como pode ser observado na Figura 3. (VARELLA, 

2003). 
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Figura 3 - Detalhe de Ovário Normal e Ovário Policístico 

            Fonte: Ovários... ([2012?]). 
 

A matéria que consiste os cistos, independente da consistência, pode 

atrapalhar o funcionamento do ovário, tanto em termos de fertilidade quanto ainda a 

correta pré-produção de hormônios. Existem mulheres que possuem os ovários 

policísticos, repletos dessas bolsas, que em muitos casos, não tem gravidade 

fisiológica, porém, cerca de 10% dos casos estão ligados a certos sintomas. 

(BULUN; ADASHI, 2008). 

De acordo com Hohl (2008), uma em cada 15 mulheres em idade reprodutiva 

tem SOP, e a resistência insulínica atinge de 50 a 70% das mulheres com a 

Síndrome. E, essa resistência independe do peso corporal da mulher. A literatura 

mostra a prevalência em torno de 5% a 10% da população feminina em idade fértil. 

 Segundo Harrington ([199-?]), para que os ovários sejam considerados 

policísticos precisam contém muitos pequenos cistos – no mínimo dez. Algum 

desses cistos contém óvulos, alguns são inativos, e outros podem secretar 

hormônios. Os cistos são pequenos, em geral com não mais que 8 milímetros, mas 

possíveis de serem visualizados com o uso do ultrassom. Dosagens sanguíneas 

também podem revelar alterações dos níveis hormonais características dos ovários 

policísticos, mas esses níveis variam consideravelmente de uma mulher para outra. 
 

3.1 DIFERENÇAS ENTRE CISTO NO OVÁRIO E OVÁRIO POLICÍSTICO 
 

Segundo Varella (2003), a principal diferença encontrada entre um simples 

cisto no ovário e a Síndrome do Ovário Policístico está relacionada ao tamanho e 

ainda ao número de cistos constantes. A síndrome do Ovário Policístico acontece 

especialmente com mulheres de faixa etária compreendida entre 30 e 40 anos e a 
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descoberta da doença tem se tornado cada vez mais eficaz graças a popularização 

do uso do ultrassom. 

 De acordo com UENO (2004), aproximadamente 25% das mulheres que 

estão na idade fértil possuem cistos no ovário, no entanto, nem todas sofrem da 

síndrome do ovário policístico. Para que haja um diagnóstico preciso da doença, é 

necessário que exista a observação de uma gama de sintomas. 

Os sintomas mais frequentes segundo Pinheiro (2014) são:  

a) alterações menstruais: a menstruação passa a acontecer de maneira 

mais espaçada e irregular, geralmente a pessoa passa a menstruar 

algumas vezes durante o ano. Isso ocorre devido à anovulação ou 

excesso de hormônios andróginos; 

b) virilização: tamanho reduzido de mamas, aprofundamento no timbre da 

voz, hipertrofia do clitóris, e rareamento dos cabelos conhecido como 

calvície padrão masculino. Esses sintomas ocorrem devido aos hormônios 

masculinos presentes; 

c) hirsutismo: acréscimo de pelos em áreas anatômicas de características 

masculinas como abdômen, seios e rosto também causado pelos 

hormônios masculinos; 

d) obesidade: diabetes tipo 2 e índices elevados de colesterol: Ocorrem 

devido a resistência a insulina. A obesidade ou aumento significativo no 

peso é extremamente prejudicial, pois pode consequentemente fazer a 

síndrome piorar; 

e) acne: em razão a uma maior produção do material oleoso pelas glândulas 

sebáceas, as espinhas formadas pela síndrome costumam se encontrar 

mais concentradas na região do queixo; 

f) para tratar essa acne não basta apenas ter cuidado com a pele, é 

necessário estar aliado com o tratamento hormonal; 

g) alto índice de infertilidade;  

h) maior risco de câncer de endométrio; 

i) possível maior risco de câncer de mama; 

j) marcas escuras ou grossas na pele e dobras ao redor das axilas, nas 

virilhas, no pescoço e nas mamas devido à sensibilidade à insulina. 
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3.2 CAUSAS 
 

 De acordo com Bulun e Adashi (2008), os hormônios sexuais femininos 

incluem estrógeno e progesterona, assim como os hormônios chamados 

andrógenos, frequentemente chamados de “hormônios masculinos”, também estão 

presentes nas mulheres, mas em quantidades diferentes. 

 Os hormônios ajudam a regular o desenvolvimento normal de óvulos nos 

ovários durante cada ciclo menstrual. A síndrome de ovário policístico está 

relacionada a um desequilíbrio nesses hormônios sexuais femininos. Um excesso de 

hormônio andrógeno é produzido, junto com alterações em outros níveis hormonais. 

(BULUN; ADASHI, 2008). 

 
Os fatores que levam ao desenvolvimento da SOP não são totalmente 
conhecidos, mas ela tem origem genética, em parte, pois irmãs ou filhas de 
uma mulher portadora do distúrbio tem 50% de chance de desenvolvê-la. 
Tudo indica que sua origem está associada com a produção da insulina em 
excesso pelo organismo. O aumento da quantidade dessa substância no 
sangue (a hiperinsulinemia) provocaria o desequilíbrio hormonal. 
(ASSOCIAÇÃO DE OBSTETRÍCIA E GINECOLOGIA DO ESTADO DE SÃO 
PAULO, [2015]). 

 

3.3 TRATAMENTO 

 

 A Síndrome do Ovário Policístico é uma endocrinologia crônica e, até agora, 

incurável. No entanto, existem diversos tratamentos desenvolvidos sob medida, e de 

acordo com os objetivos de cada paciente capazes de atenuar os sintomas, ou seja, 

o tratamento será sintomático. 

Varela destaca que foi demonstrado que a perda de peso ajuda com a 

diabetes, a pressão arterial alta e o colesterol alto. Mesmo uma perda de 5% do 

peso corporal total mostrou ajudar com o desequilíbrio hormonal e a infertilidade 

podendo até reverter o quadro. 

O autor ainda ressalta que os principais medicamentos usados para tratar dos 

hormônios e ciclos menstruais anormais decorrentes da síndrome de ovário 

policístico incluem: 

a) pílulas anticoncepcionais ou comprimidos de progesterona, para ajudar os ciclos 

menstruais a se tornarem mais regulares. 
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b) metformina, um medicamento que aumenta a sensibilidade do corpo à insulina, pode 

melhorar os sintomas da síndrome de ovário policístico e às vezes fará com que os 

ciclos menstruais sejam normalizados. Para algumas mulheres, ele também pode 

ajudar com a perda de peso. 

c) análogos do hormônio liberador do hormônio luteinizante (LHRH) - O tratamento 

com citrato de clomifeno faz com que o óvulo amadureça e seja liberado. Algumas 

vezes as mulheres precisam dele ou de outros medicamentos para fertilidade a fim 

de engravidarem. 
 

3.4 ALGUMAS IMAGENS DA SÍNDROME DO OVÁRIO POLICÍSTICO 
 

 Em imagens de ultrassom os ovários que apresentam a presença de cistos, 

como pode ser observado na Figura 4, é possível observar pequenas formas 

circulares escuras, com tamanhos diversificados e com quantidades variadas. 

                 

                       Fonte: MEDSCAN – Medicina Diagnóstico. 

 

Em algumas imagens de ultrassom, como a anterior, os cistos não são 

nítidos, dificultando a visualização imediata de sua quantidade e tamanho, já em 

outras essas informações são mais evidentes, como mostra na Figura 5. 

 
 
 
 
 
 

Figura 3 - Ultrassom: microcistos periféricos no ovário. 
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                                  Fonte: Grupo Criogênesis. 
 

 
 Nota-se na Figura 6 a diferença do ovário direito e esquerdo da paciente. 

Existem casos que podem apresentar a enfermidade em apenas um dos ovários. 

Não é o caso dessa imagem pois a doença é presente em ambos ovários. 

                                Fonte: Learning Radiology, 2006.                 
                            
 
 
 

Figura 4 - presença de vários cistos pequenos (setas brancas) na 
periferia do ovário. 

Figura 5 - Ambos ovários com a Síndrome. 
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4 IMAGENS MÉDICAS 

 

Antes de iniciar esse aperfeiçoamento de diagnóstico utilizando o 

processamento de imagens, é necessário ressaltar a importância das imagens 

médicas, sem elas essa avaliação seria impossível. A partir de um padrão 

estabelecido é possível julgá-las e propiciar um resultado adequado de acordo com 

o que é demonstrado de cada paciente. 

 Dentre algumas técnicas presentes que se é possível adquirir essas imagens, 

é importante destacar a ultrassonografia que irá nos auxiliar a visualização dos 

ovários e fará com que seja possível a avaliação adequada. 
 

4.1 ULTRASSONOGRAFIA 

 

 De acordo com Seabra (2007), a ultrassonografia (ou ecografia) é um método 

utilizado para diagnóstico que utiliza o eco produzido pelo som para verificar em 

tempo real as reflexões produzidas pelas estruturas e órgãos do organismo do 

paciente. Os aparelhos ultrassonográficos geralmente utilizam uma frequência 

variada dependendo do tipo de transdutor, emitindo através de uma fonte de cristal 

piezoeléctrico que fica em contato com a pele, e recebe os ecos gerados, os quais 

serão interpretados através do uso da computação gráfica. 

 A sonda funciona como emissor/receptor e quanto maior a frequência, maior 

a resolução obtida, e consequentemente mais precisão existe na visualização das 

estruturas superficiais. Conforme a densidade e composição das interfaces, a 

atenuação e mudança de fase dos sinais emitidos varia, sendo possível a tradução 

de uma escala de cinza que formará a imagem dos órgãos internos. (SEABRA, 

2007). 
 

Através do uso do preciso “Efeito Doppler” (nome designado a homenagem 
ao Johann Christian Andreas Doppler, seu criador), a ultrassonografia 
permite também detectar o sentido e a velocidade da corrente sanguínea 
em determinado segmento do corpo. É o método ideal para examinar 
mulheres gestantes, durante o acompanhamento pré-natal, permitindo 
reconhecer o sexo do bebê antes do nascimento, bem como diagnosticar 
eventuais alterações morfológicas ou funcionais do feto, realizar 
intervenções intrauterinas e prever as que serão necessárias após o 
nascimento. (ABC.MED.BR, 2012). 
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 Os médicos destacam as principais vantagens e desvantagens do uso dessa 

técnica (ABC.MED.BR, 2012.), entre as quais destacam-se: 

a) é um exame que em geral não exige preparo prévio ou, em alguns casos, 

apenas uma preparação simples, como um jejum de 6 a 8 horas e a 

repleção da bexiga. 

b) é um exame não invasivo e indolor que fornece imagens dinâmicas em 

tempo real, sem o uso de radiações, amplamente disponível, de fácil uso 

e custo relativamente baixo. 

Contudo, as desvantagens são: 

a) não permite uma boa visualização das cavidades ou dos órgãos que 

contenham gases. 

b) a visualização das estruturas em pacientes obesos é mais difícil. 

Em casos de exame de ossos, apenas pode ser visualizada a 

superfície externa deles. 
 

 Seabra (1997) ressalta que, sendo assim, a ultrassonografia é um dos 

métodos de diagnóstico por imagem mais versáteis e ubíquos, de aplicação 

relativamente simples. É um dos métodos de diagnóstico utilizando imagens mais 

usado na detecção de doenças, pelo fato de não utilizar radiação em pósitrons, 

como na radiografia e tomografia computadorizada é um método inofensivo, 

totalmente indolor e não ocasiona nenhum incômodo e, além disso, pouco custoso. 

 Em contrapartida, a principal desvantagem é que a qualidade da imagem 

dependerá da habilidade do operador, tendo em vista também a baixa resolução 

espacial e a presença de ruídos constante na imagem. É importante considerar que 

ruídos de outros equipamentos podem ser captados pelo aparelho de ultrassom 

gerando faixas lineares ou pontos na imagem, criando certas deformações e 

irregularidades capazes de dificultar a análise do exame. (BRONSON, 2002; BEGA 

et al, 2001). 
 

4.2 SISTEMAS DE DIAGNÓSTICO AUXILIADO POR COMPUTADOR 

  

O Diagnóstico auxiliado por computador ou “Computer-aided diagnosis” 

(CAD) é definido por Giger (2000), como aquele no qual o radiologista usa os 

resultados de uma análise computadorizada de imagens médicas como uma 
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“segunda opinião” na detecção de lesões e na elaboração do diagnóstico. Técnicas 

de imagem em raio-x, ressonância magnética e ultrassom são os principais meios de 

informação que são analisados pelos radiologistas. O CAD também auxilia no 

escaneamento de tomografias computadorizadas, podendo destacar aparições 

típicas e seções visíveis, verificando a existência das doenças. 

 Tendo em vista que o diagnóstico baseado apenas em imagens de pacientes 

não é uma tarefa fácil, a ideia de utilizar o computador como um auxílio para 

melhorar a interpretação das imagens é algo considerável e a junção da inteligência 

artificial junto ao diagnóstico auxiliado por computador é algo incrível para a 

evolução do tratamento dos pacientes com uma melhor qualidade. 
 

O objetivo do CAD é melhorar a acurácia do diagnóstico e também a 
consistência da interpretação dos radiologistas de imagens usando a saída 
do computador como um guia. A saída do computador pode ser muito útil, 
pois o diagnóstico de um radiologista  é feito com base no julgamento 
subjetivo e tendem a perder lesões como nódulos pulmonares em 
radiografias de tórax, microcalcificações e massas em mamografias. Além 
disso, as variações de diagnóstico, tais como inter-observador e infra-
observador, podem ser grandes. (DOI, 1999). 

 

 O algoritmo CAD apresenta várias etapas que podem incluir processamento 

de imagens, análise de recursos de imagens e classificação de dados através do 

uso de ferramentas de redes neurais artificiais ou Artificial Neural Network (ANN).  

 As Redes neurais artificiais (RNA) são modelos computacionais inspirados em 

um sistema nervoso central de um animal (particularmente o cérebro) que possibilita 

o mecanismo de aprendizado e reconhecimento de padrões existentes. São 

basicamente representados como sistemas de “neurônios”, que se interconectam 

podendo calcular os valores das entradas. (SILVA; SPATTI; FLAUZINO, 2010). 

 O CAD combina elementos de inteligência artificial e processamento de 

imagens digital e radiológica, sendo utilizado em mamografia como exames 

preventivos, diagnóstico de câncer de mama, e até mesmo detecção de pólipos no 

cólon e câncer de pulmão. 

 Porém, Marques (1999) cita que os principais objetos de pesquisa para o 

desenvolvimento de sistemas CAD têm sido as áreas de mamografia, para a 

detecção precoce do câncer de mama; tórax, para a detecção de nódulos 

pulmonares, lesões intersticiais e pneumotórax; e angiografia, para a análise 

quantitativa de estenoses e de fluxo sanguíneo.  
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Com o objetivo de auxiliar no diagnóstico de achados mamográficos, 
diversos trabalhos utilizando técnicas de Processamento de Imagens, 
Reconhecimento de Padrões, Visão Computacional e Inteligência Artificial 
vêm sendo desenvolvidos, como parte de esquemas CAD (Computer Aided 
Diagnosis), buscando melhorar a visibilizarão de imagens radiográficas por 
meios computacionais para auxiliar radiologistas na detecção de lesões 
(DOI et al., 1995; GIGER, 1999; ARBACH et al., 2003; BALL et al., 2004; 
PATROCINIO et al. 2004; ZHENG et al., ZWIGGELAAR et al., 2004 apud 
RIBEIRO, 2006, p.22.). 

 

Em um de seus artigos, Ribeiro (2006) destaca a difícil interpretação do 

contorno dos nódulos mamários, e ressalta que as distorções na interpretação e 

classificação das lesões suspeitas pelos especialistas podem implicar em um grande 

número de biópsias desnecessárias e, portanto, o autor argumenta a importância do 

sistema CAD no auxílio dos especialistas para diagnosticas essas lesões. 
 

Os esquemas CAD utilizam imagens digitais, sendo, na maioria das vezes, 
os filmes mamográficos digitalizados com equipamentos de alta resolução 
seguindo técnicas específicas, junto com informações do paciente. A partir 
da localização de padrões anormais através da varredura de imagem pelo 
computador, e da quantificação de características da imagem, essas 
informações serão enviadas para um sistema classificador que poderão 
classificar as imagens em normais ou anormais. Tais esquemas podem 
funcionar como uma segunda opinião aos radiologistas quanto à localização 
e à natureza destas estruturas. (DOI et al., 1995; GIGER, 1999; 
VELTHUIZEN, 2000 apud RIBEIRO, 2006, p. 22.). 
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5 PROCESSAMENTO DE IMAGENS 
 

Marques Filho e Vieira Neto (1999) descrevem a área de processamento de 

imagens como sendo objeto de crescente interesse por permitir viabilizar grande 

número de aplicações em dois seguimentos diferentes. O primeiro seria o 

aprimoramento de informações pictóricas para interpretação humana, já o segundo a 

análise automática por computador de informações extraídas de uma cena 

De acordo com Antunes, são técnicas voltadas para análise de dados 

multidimensionais adquiridos por diversos sensores podendo ser utilizadas para 

melhorar o aspecto visual de feições estruturais para ser analisada por um humano 

fornecendo assim outros subsídios para a sua interpretação, podendo também gerar 

produtos a serem posteriormente submetidos a outros tipos de processamento. 
 

Podemos atribuir a muitos fatores a multiplicação das modalidades de 
produção de imagens médicas, tais como a melhor compreensão dos 
princípios básicos da captação de imagens, aperfeiçoamento de técnicas 
matemáticas de reconstrução, a evolução dos computadores com 
desenvolvimento de equipamentos mais baratos e mais seguros. Esta 
melhoria na tecnologia da computação levou a uma tendência para a 
geração de imagens digitais, e os exames tradicionais de raios X podem 
agora ser adquiridos e processados pelo computador. A aquisição e análise 
de imagens digitais de raios-X formam a base de um novo campo chamado 
radiologia digital. (ALMEIDA, 1998). 

  

Segundo Albuquerque é presente em diversas áreas como análise de 

recursos naturais e meteorológicos via imagens de satélites, transmissão digital de 

sinais de televisores, análise de imagens metalográficas e de fibras vegetais, análise 

de imagens biomédicas, obtenção de imagens médicas para ultrassom, radiação 

nuclear ou técnicas de tomografia computadorizada e aplicação em automação 

industrial envolvendo o uso de sensores visuais em robôs. 
 

De 1964 aos dias atuais, a área de processamento de imagens vem 
apresentando crescimento expressivo e suas aplicações permeiam quase 
todos os ramos da atividade humana. Em Medicina, o uso de imagens no 
diagnóstico médico tornou-se rotineiro e os avanços em processamento de 
imagens vêm permitindo tanto o desenvolvimento de novos equipamentos 
quanto a maior facilidade de interpretação de imagens produzidas por 
equipamentos mais antigos, como por exemplo o de raio-X. (MARQUES 
FILHO, O.; VIEIRA NETO, H., 1999) 
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        Fonte: MARQUES FILHO, O.; VIEIRA NETO, H., (1999). 

 

Os principais elementos de um processamento de imagem de uso genérico 

podem ser observados através da Figura 7. O diagrama apresenta desde sistemas 

com pouco custo até sofisticadas estações de trabalhos utilizadas em aplicações 

envolvendo intenso uso de imagem. Ele mostra as principais operações efetuadas 

sobre uma imagem como aquisição, armazenamento, processamento e exibição. 
 

 Marques Filho e Vieira Neto (1999) descrevem os principais elementos do 

processamento de imagens, dividindo-os em: 
 

a) Aquisição: A etapa de aquisição tem como função converter uma imagem 

em uma representação numérica adequada para o processamento digital 

subsequente. 

b) Armazenamento: O armazenamento de imagens digitais é um dos 

maiores desafios no projeto de sistemas de processamento de imagens, 

em razão da grande quantidade de bytes necessários para tanto. Este 

armazenamento pode ser dividido em três categorias: (1) armazenamento 

de curta duração de uma imagem, enquanto ela é utilizada nas várias 

etapas do processamento, (2) armazenamento de massa para operações 

Figura 6 - Principais elementos do processamento de imagens. 
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de recuperação de imagens relativamente rápidas, e (3) arquivamento de 

imagens, para recuperação futura quando isto se fizer necessário. 

c) Processamento: O processamento de imagens digitais envolve 

procedimentos normalmente expressos sob forma algorítmica. Em função 

disto, com exceção das etapas de aquisição e exibição, a maioria das 

funções de processamento de imagens pode ser implementada via 

software. O uso de hardware especializado para processamento de 

imagens somente será necessário em situações nas quais certas 

limitações do computador principal (por exemplo, velocidade de 

transferência dos dados através do barramento) forem intoleráveis. 

d) Transmissão: Imagens digitalizadas podem ser transmitidas à distância 

utilizando redes de computadores e protocolos de comunicação já 

existentes. O grande desafio da transmissão de imagens à distância é a 

grande quantidade de bytes que se necessita transferir de uma localidade 

a outra, muitas vezes através de canais de comunicação de baixa 

velocidade e banda passante estreita. 

e) Exibição: O monitor de vídeo é um elemento fundamental de um sistema 

de processamento de imagens. Os monitores em uso atualmente são 

capazes de exibir imagens com resolução de pelo menos 640 x 480 pixels 

com 256 cores distintas. A tecnologia mais usual ainda é o TRC (Tubo de 

Raios Catódicos). 
 
5.1 MÉTODOS DE PROCESSAMENTO E ANÁLISES 

 

 O processamento de imagens é, na maioria das vezes, feito por 

computadores pessoais. É geralmente mais versátil, confiável e preciso, além de ser 

mais fácil de implementar que seus duais analógicos. Hardwares especializados são 

usados para o processamento digital de imagem, contando com arquiteturas de 

computador paralelas para tal, em sua maioria no processamento de vídeos.  

Albuquerque (2000) explica que o módulo de entrada é constituído pelos 

sensores que captam a "imagem" (uma informação organizada sob a forma de pixels 

em duas dimensões), e em seguida, enviam os sinais de vídeo, a um conversor 

analógico digital. Uma imagem digital é discretizada espacialmente, ou seja, em x e 

y e em luminância que apresentam os níveis de cinza.  
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 Após a conversão da imagem pelo modulo de conversão analógica digital, 

cada intensidade indexa uma tabela de conversão. Esta tabela é na realidade 

memórias de acesso rápido que possibilitam a modificação das intensidades 

adquiridas por valores pré-programados. A imagem digital é em seguida 

armazenada em uma memória principal de acesso exclusivo de um processador 

gráfico. Este processador é bastante dependente do sistema de processamento de 

imagens utilizado. (ALBUQUERQUE, 2000). 

Segundo o autor citado anteriormente, em alguns casos ele pode não existir, 

deixando todo o processamento para o processador principal no computador de 

controle. Este fato dependerá se o computador possuí ou não um processador 

potente. No caso de imagens coloridas cada componente da imagem ("Red", 

"Green" e "Blue") é armazenado separadamente na memória principal. A imagem de 

saída é geralmente reconstruída através de conversores digitais/Analógicos (DAC), 

onde são somados pulsos de sincronização para geração do sinal de vídeo. Antes 

de ser reconvertido o sinal pode passar por outra tabela, desta vez a tabela de 

saída, que nos permite ajustar regiões da imagem em função da intensidade dos 

pixels. Podemos assim associar falsas cores e observarmos "on-line" diferentes 

regiões, separadas por diferentes níveis de cinza (técnica conhecida como "density 

slice"). A Figura 8 apresenta um exemplo da técnica de "falsas cores" usada em uma 

imagem de aglomerações de líquidos magnéticos.  

Figura 7 - Uso de falsas cores. 

     Fonte: Albuquerque, M. P. 
                

Ainda de acordo com Albuquerque (2000), resumidamente, as células 

observadas na Figura 8 correspondem a uma maior densidade do líquido magnético, 

observada através de uma técnica conhecida como Densimetria. A fonte luminosa 

envia um feixe de luz através do líquido. Cada pixel na imagem digital representa na 

realidade uma medida da absorção da luz pelo liquido. Nas regiões mais escuras a 
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absorção da luz é maior, nas mais claras, esta é menor. As falsas cores permitem 

rapidamente relacionar as regiões equivalentes (em intensidade luminosa) em 

diferentes partes da imagem. 
 

5.2 PIXEL – ORGANIZAÇÃO EM UMA MATRIZ QUADRADA 
 
 
 Goya descreve um pixel ("picture element" ou "pel") como o elemento básico 

em uma imagem. Sendo a forma mais comum para o pixel a retangular ou quadrada. 

O pixel é também um elemento de dimensões finitas na representação de uma 

imagem digital. Frequentemente, a organização de uma imagem sob a forma de 

uma matriz de pixels é feita em uma simetria quadrada, na forma de um tabuleiro de 

xadrez. Isto se deve a facilidade de implementação eletrônica, seja dos sistemas de 

aquisição seja dos sistemas de visualização de imagens. 

 

5.3 DISTÂNCIAS 

 

 Quando trabalhamos com imagens é muito comum medirmos distâncias. Em 

muitos casos usamos a definição clássica de distância euclidiana entre dois pontos. 

Porém se torna evidente que a simetria quadrada interfere na execução de alguns 

algoritmos. Existem diferentes medidas de distância em função da conectividade 

utilizada. Por exemplo, se considerarmos dois pontos p(x,y), q(s,t), teremos as 

seguintes definições de distância.(GONZALES ; WINTZ, 1987). 

 Albuquerque (2000) exemplifica o conceito de distâncias com a imagem de 

conexão de dois pontos p(x,y) e q(s,t). Como é observado na Figura 9, a distância 

entre dois pontos pode ser determinada de diversas maneiras. Os números 1 e 2 

representam os pixels que seriam percorridos somente uma vez nas duas 

representações possíveis quando saímos de p para q. O número 3 indica os pixels 

‘‘percorridos duas vezes.  
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Figura 8 - Conexão de dois pontos p(x,y) e q(s,f). 

                                               Fonte: Albuquerque, M. P. 
 

A Figura 9 mostra a conexão entre dois pontos p(x,y) e q(s,t). A distância 

entre estes dois pontos pode ser determinada de diversas maneiras. Os números 1 

e 2 representam os pixels que seriam percorridos somente uma vez nas duas 

representações possíveis quando saímos de p para q. O número 3 indica os pixels 

percorridos pelos dois caminhos. 

 Distância Euclidiana:   

 Distância "Manhattan":  
 

 Distância Tabuleiro de Xadrez (em analogia a um tabuleiro de Xadrez):

   
 

5.4 FILTRAGEM 

 

 Albuquerque (2000) explica que em processamento de imagens, os filtros 

lineares são geralmente descritos através de matrizes de "convolução". Como 

mostrado na Figura 10. No caso um filtro numérico vai influenciar a variação da 

frequência espacial em uma imagem. Na frequência temporal a escala usada é 

geralmente o Hertz (s^-1), já em uma imagem usamos o 1/metro (m^-1) ou 1/pels 

(pix^-1). O termo frequência espacial é análogo ao termo frequência temporal e ela 

descreve a velocidade de modificação de uma luminosidade em uma imagem. 
 

Na prática, para realizarmos uma operação de filtragem espacial, devemos 
escolher uma matriz de dimensão n x n com valores que dependem do filtro 
que queremos usar, seja ele passa baixa (filtrando as altas frequências), 
passa faixa (filtrando uma região específica de frequências espaciais) ou 
passa alta (filtrando as baixas frequências). Em uma imagem as altas 
frequências correspondem as modificações abruptas dos níveis de cinza, 
i.e., as bordas dos objetos. As baixas frequências correspondem as 
variações suaves dos níveis de cinza. Logo quando queremos evidenciar os 
contornos de um determinado objeto podemos usar filtros do tipo passa-
alta. Em outros casos podemos estar interessados na forma da iluminação 
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de fundo, onde devemos usar filtros passa-baixa para eliminarmos todas as 
altas frequências correspondendo a borda dos objetos, e chegar a 
iluminação de fundo. (ALBUQUERQUE, 2000). 
 

Figura 9 - Matrizes da Filtragem de uma imagem. 

                           Fonte: ALBUQUERQUE. 
 

A Figura 10 mostra a imagem que equivale à um filtro Médio (passa-baixas). 

Os contornos perdem ligeiramente a nitidez. (c) - Filtro de detecção de variações 

bruscas no sentido horizontal (Passa-Alta). (d) - Filtro também Passa-Alta que 

melhora o contraste da imagem realçando os contornos do objeto. 

 

5.5 SEGMENTAÇÃO 

 

 Thomé (2004) descreve a Segmentação como tarefa básica no 

processamento de imagens, subdividindo uma imagem em suas partes ou objetos 

constituintes que devem corresponder a áreas de interesse da aplicação. O nível da 

subdivisão será feito dependendo da questão a ser resolvida.  

 O autor ainda descreve essa tarefa como sendo uma das mais difíceis em 

processamento de imagens, pois determina o sucesso ou fracasso dessa análise. 

Tendo como objetivo aumentar a confiabilidade e o resultado da segmentação, 

deve-se fazer o uso de todo e qualquer conhecimento prévio sobre o problema. 

              Os algoritmos de segmentação são geralmente baseados na busca pelas 

descontinuidades ou pelas similaridades dos níveis de cinza. (THOMÉ, 2004). 

O autor ainda ressalta que ao analisar uma imagem o resultado pretendido 

não é, geralmente, outra imagem, mas antes uma descrição. Essa descrição refere-

se, em regra, a partes específicas da imagem ou da cena. O processo de decompor 
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uma imagem nas suas partes constituintes designa-se por segmentação (divisão em 

segmentos). 

Esse processo de segmentação pode ser considerado como um processo de 

classificações de pixels. Se as classes e as suas probabilidades, bem como as 

propriedades (p.ex., brilho) e as suas probabilidades por classes, forem conhecidas 

a priori, a segmentação reduz-se a um problema clássico de decisão estatística. 

Quando as classes não são conhecidas pode recorrer-se a técnicas de agrupamento 

(clustering). (THOMÉ, 2004). 

 

 
             Figura 10 - Exemplo (5 classes). 

 
  Fonte - Padilha 

 
5.5.1 Thresholding  
 

A classificação é muitas vezes baseada no histograma de uma propriedade 

(em geral, o nível de cinzento).  

A. J. Padilha destaca que dado o número de pixels numa imagem ser 

geralmente muito elevado pode-se considerar o histograma como uma boa 

aproximação à densidade de probabilidade da propriedade que ele representa.  

De acordo com o autor citado anteriormente, é possível observar na Figura 12 

o thresholding com 1 único limiar de separação (binarização). A seleção do limiar de 

separação (separação entre as classes “claro” e “escuro” no caso da propriedade 

ser o brilho) faz-se geralmente no vale do histograma, sendo este bimodal. 
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Figura 11 - Exemplo de Thresholding. 

 
 Fonte - Padilha. 
 
5.6 RECONHECIMENTO 

 

 Albuquerque (2000) descreve a parte do reconhecimento como a que 

classificará os objetos a partir de informações encontradas na imagem, de acordo 

com o banco de dados previamente estabelecido. É comumente aplicada após a 

Segmentação e de uma fase de parametrização que identifica, e calcula alguns 

parâmetros (pré-determinados) nos objetos segmentados (como exemplo de algum 

parâmetro pode ser citado o perímetro ou a área de uma determinada forma). 
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6 TÉCNICAS DE PROCESSAMENTO DE IMAGENS 

 

As técnicas descritas a seguir foram as estudadas e pesquisadas que, 

posteriormente, foram utilizadas para executar o processamento com êxito. A partir 

das explicações a seguir é possível entender como cada técnica teve seu papel de 

grande importância para obter o resultado desejado. No caso, em meio a várias 

técnicas existentes, foram estas que trouxeram um melhor resultado. 

 

6.1  EQUALIZAÇÃO DO HISTOGRAMA 

 

O processo de equalização de histograma como visando o aumento da 

uniformidade da distribuição de níveis de cinza de uma imagem, sendo usualmente 

empregado para realçar diferenças de tonalidade na imagem e resultando, em 

diversas aplicações, em um aumento significativo no nível de detalhes perceptíveis. 

(QUEIROZ; GOMES, 2011). 

Ao efetuar essa equalização é possível obter a máxima variância do 

histograma de uma imagem, obtendo assim uma imagem com o melhor contraste. O 

contraste é uma medida qualitativa e que está relacionada com a distribuição dos 

tons de cinza em uma imagem. Para equalização do histograma, sendo trabalhadas 

com três técnicas distintas: equalização global, equalização regional por blocos e 

equalização regional pontual.  
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              Figura 12 - Exemplo de equalização histogrâmica. 

 
                Fonte: QUEIROZ; GOMES (2011). 
 

Os autores citados anteriormente destacam um modo simples de equalizar o 

histograma de uma imagem de dimensões M x N com L níveis de cinza advém da 

transformação: T(nce) = rnd[((L-1)/M.N).Hf(nce)], (10) na qual rnd representa o 

arredondamento do resultado da expressão para o inteiro mais próximo. Na Figura 

13 é possível observar o processo da equalização histogrâmica. 

De acordo com Brazil ([199-?]), após a aquisição das imagens, muitas vezes 

percebemos a necessidade de realizar um pequeno ajuste, de forma a compatibilizar 

algumas distorções que podem ocorrer durante a etapa de aquisição das imagens, 

principalmente por parte de diferenças de iluminação de ambiente e dos dispositivos 

de captura, o que poderia comprometer futuramente o processo de reconhecimento 

das texturas durante as etapas de reconhecimento e comparação das características 

das imagens.  
         Equalizar o histograma significa obter a máxima variância do histograma de 

uma imagem, obtendo assim uma imagem com o melhor contraste. O contraste é 

uma medida qualitativa e que está relacionada com a distribuição dos tons de cinza 

em uma imagem. Para equalização do histograma, trabalhamos com três técnicas 

distintas: equalização global, equalização regional por blocos e equalização regional 

pontual. 
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6.2  SUAVIZAÇÃO 

 

A suavização de imagens é utilizada para reduzir ruído, realçar as 

características da imagem e para reduzir detalhes não desejados. A maioria das 

técnicas de suavização pode ser classificada em três famílias: mediação local, 

suavização baseada em modelos, suavização geométrica. (FACON, 1998). 

 

6.2.1 SUAVIZAÇÃO BASEADA EM MEDIAÇÃO LOCAL 

De acordo com Facon (1998), a suavização baseada nas operações de 

mediação local pressupõe o nível de intensidade sobre toda a imagem. Essa 

hipótese é um caso especial da suposição mais geral de que a maioria das imagens 

descreve a superfície de cenas contínuas numa resolução de imagem adequada 

para a interpretação ser possível.  

Em uma abordagem de suavização baseada nessa concepção, troca-se o 

centro de uma pequena região em volta de um pixel (tipicamente uma janela 

quadrada) pela média ponderada dos valores encontrados nessa janela; essa 

operação é idêntica para cada pixel da imagem. Outra abordagem usada para evitar 

o efeito de pixels indesejados e para preservar as bordas consiste em usar o filtro da 

mediana, no lugar da média, dos valores de intensidade da janela. 

6.2.2 SUAVIZAÇÃO BASEADA EM MODELOS PRÉ-DEFINIDOS 

 

O autor ainda descreve essa técnica como típica de uma abordagem global 

para suavização. Supondo que tenhamos um modelo de como a iluminação varia 

em uma imagem. Por exemplo: se nós sabemos que a iluminação pode ser 

modelada como uma função quadrática, nós podemos ajustar uma superfície 

quadrática nos valores de intensidade dos pixels em uma porção estendida da 

imagem. A intensidade de cada pixel é então subtraída do valor correspondente da 

superfície ajustada, deixando somente as variações de grande ordem do sinal 

subjacente. Assim, impede-se que um artefato conhecido interfira na nossa análise 

da informação intrínseca que reside na imagem. 
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5.2.3 Suavização geométrica 

 

Facon (1998) destaca que a suavização geométrica de uma imagem pode ser 

realizada assumindo-se que pequenas regiões isoladas consistem em ruídos e 

podem ser eliminadas e que pequenos furos (intervalos) entre regiões são artefatos 

da imagem que podem ser preenchidos. Tal suavização pode ser prontamente 

realizada em imagens binárias usando sequências de operações de emagrecimento 

e crescimento. Nesta abordagem de emagrecimento e crescimento, para eliminação 

de pequenas regiões ruidosas, usa-se primeiro a operação de emagrecimento na 

qual pixels pretos que não estejam completamente cercados de pretos são 

convertidos para brancos.  

A operação de emagrecimento pode ser realizada de forma interativa muitas 

vezes. Uma operação de crescimento pode então ser usada na qual todos os pixels 

pretos que não são completamente cercados por pretos são providos com pixels 

pretos ao redor. Qualquer pequena região de ruído preta terá sido eliminada pelas 

operações de emagrecimento, e as maiores regiões serão mantidas inalteradas se 

os números de operações de emagrecimento e crescimento forem iguais. (Facon, 

1998).  

 

6.3 THRESHOLD OU LIMIARIZAÇÃO 

 

De acordo com Mello, limiarização é uma das mais importantes abordagens 

para a segmentação de imagens. Na Limiarização analisamos a similaridade dos 

níveis de cinza da imagem extraindo os objetos de interesse através da seleção de 

um limiar T que separa os agrupamentos de níveis de cinza.  

O autor citado frisa que a mais simples de todas as técnicas de limiarização é 

a do particionamento do histograma da imagem por um limiar único T). A 

segmentação é então efetuada, varrendo-se a imagem, pixel por pixel, e rotulando-

se cada pixel como sendo do objeto ou do fundo, dependendo se o nível de cinza 

daquele pixel for maior ou menor que T. O sucesso desse método depende 

inteiramente de quão bem o histograma pode ser particionado.  

Uma das dificuldades da “limiarização” de uma imagem é a melhor 

determinação do valor de “thresholding”, ou seja, do ponto de separação dos pixels.  
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É possível observar na Figura 14 a utilização do método do vale: Através da 

análise do histograma estabelecer T (valor de “Threshold”) na região de “vale” mais 

próxima ao meio de escala dos níveis de cinza. 

Mello exemplifica a Conversão de uma imagem para dois tons a partir de um dado 

ponto de corte (limiar):  

 

                      Figura 13 - Conversão de Imagem. 

 
                       Fonte: MELLO. 

 

A seguir podemos observar como é feito o processamento de cheques, tendo 

o seu background como desnecessário irá retornar apenas as informações 

necessárias. 
 
     Figura 14 -  Processamento de Cheques. 

 
       Fonte: MELLO. 
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      Figura 15 - Processamento de Cheques. 

 
    Fonte: MELLO. 
 

6.4  EROSÃO E DILATAÇÃO 

 

Ren descreve Erosão e Dilatação como operadores morfológicos 

fundamentais: 

Dilatação  

 Sendo A e B conjuntos de Z 2 e ∅ o conjunto vazio, define-se a 

dilatação de A por B, denotada por A ⊕B, como ilustra a Figura 18. 

                                    Figura 16 - Formula de Dilatação. 

 
                                    Fonte: Elaborado por autor. 

 

O autor citado descreve o processo de dilatação começando na obtenção da 

reflexão de B em torno da sua origem, seguido da translação dessa reflexão por 

x. A dilatação de A por B é então o conjunto de todos os deslocamentos x tais 

que A sobreponham-se em pelo menos um elemento não nulo. 

                               Figura 17 - Formula da Dilatação. 

 
                          Fonte: Elaborado por autor. 
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O conjunto B é normalmente chamado de elemento estruturante da dilatação 

como é possível observar na Figura 19. 

 

Erosão  

 Sendo A e B em Z 2, a erosão de A por B, denotada por A ⊖ B, é denotada 

pelo que pode se observar na figura 20. 
 

                                 Figura 18 - Fórmula de erosão. 

 
                                       Fonte: Elaborada pelo autor. 
 

Ren descreve a erosão de A por B como sendo o conjunto de todos os pontos 

x tais que B, quando translado pro x fique contido em A. Como no caso da dilatação, 

essa equação não é a única definição da erosão. 

Dilatação e erosão são operações duais em relação à complementação e 

reflexão de conjuntos: 

                                   

Figura 19 - Fórmula de erosão. 

 
                                                 Fonte: Elaborada pelo autor. 
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7 FERRAMENTA IMAGEJ 

 

 De acordo com a documentação oficial da ferramenta, o ImageJ é um 

programa de processamento de imagem baseado em Java de domínio público, 

desenvolvido pelo National Institutes of Health. Foi projetado com uma arquitetura 

aberta que proporciona extensibilidade via plugins Java e macros graváveis. 

Aquisição personalizada, análise e plugins de processamento podem ser 

desenvolvidos usando o ImageJ editor built-in e um compilador Java.  

Os plugins escritos pelo usuário tornam possível resolver diversos problemas 

de processamento e análise de imagem, a partir de imagens ao vivo de células em 

três dimensões para processamento de imagem radiológica, a comparação de 

dados sistema de imagem múltipla para sistemas automatizados de hematologia. A 

arquitetura de plugins do ImageJ, e construído no ambiente de desenvolvimento 

tornou uma plataforma popular para o ensino de processamento de imagem.  

 ImageJ pode ser executado como um applet online, um aplicativo para 

download, ou em qualquer computador com uma máquina virtual Java 5 ou posterior 

como observado na Figura 22. O download é disponível para o Microsoft Windows, 

Mac OS, Mac OS X, Linux, ea Sharp Zaurus PDA. O código fonte para ImageJ 

também está disponível gratuitamente.   

 

                    
                    Figura 20 - Screenshot do ImageJ. 

 
                            Fonte: ImageJ Oficial. 
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7.1 CONCEITOS BÁSICOS 

 

O ImageJ, como descrito em seu site oficial, é uma ferramenta grátis, de 

domínio público e um software open source. 

Além de que um usuário do ImageJ possui quatro liberdades essenciais 

definidas pelo Richard Stallman em 1986: 

 A liberdade de executar o programa, para qualquer propósito. 

 A liberdade de estudar como o programa funciona, e alterá-lo para torná-lo 

hábil a fazer o que quiser. 

 A liberdade de distribuir cópias de modo a ajudar ao próximo. 

 A liberdade de aperfeiçoar o programa, e liberar os seus aperfeiçoamentos ao 

público, de modo que toda a comunidade se beneficie. 

 

                  
                       Figura 21 - Exemplo de utilização do ImageJ. 

 

                  Fonte – Documentação oficial do Imagej. 
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7.1.2 Janelas ou Windows 

 

A “janela” ou paleta contém uma barra de menu (no topo da tela), barra de 

ferramentas, barra de status, e uma barra de progresso. Imagens, histogramas, perfil 

de linha, etc. são exibidos em janelas adicionais como pode ser observado na Figura 

22. Os resultados das medições são exibidos na janela "Results". Janelas podem ser 

arrastadas pela tela e redimensionar. Histogramas e parcelas são janelas de 

imagem comuns que podem ser copiadas para o clipboard, editadas, impressas e 

guardadas. 

 

7.1.2 Barra de Ferramentas ou Toolbar 

 

A barra de ferramentas como mostrada na Figura 23 contém utensílios para 

fazer seleções, zoom e rolagem de imagens, e para alterar a cor de desenho. Passe 

o mouse sobre uma ferramenta e uma descrição é exibida na barra de status. As 

ferramentas e menus no lado direito da barra de ferramentas são criadas usando 

macros definidas no arquivo ImageJ / macros / Startup MACROS.TXT. 

 

 
Figura 22 - Barra de Ferramentas do ImageJ. 

 
Fonte: Documentação oficial do Imagej. 

 

7.1.3 Barra de Status ou Status Bar 

 

A barra de status, como ilustra a Figura 24, demonstra que quando o cursor 

está sobre uma imagem, mostra coordenadas e valores de pixels. Depois de 

executar um filtro, ela exibe o tempo decorrido e taxa de processamento em pixels / 

segundo. Clique sobre o estado e ele irá exibir (como mostrado acima) a versão 

ImageJ, a versão Java, memória em uso, a memória disponível e por cento de 

memória utilizada. 
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Figura 23 - Barra de Status do Imagej. 

 
Fonte: Documentação oficial do Imagej. 

 
7.1.4 Barra de Progresso ou Progress Bar 

Segundo a documentação oficial do Imagej, a barra de progresso, localizado 

à direita da barra de status, mostra o andamento das operações demoradas. Ele não 

irá aparecer se a operação requer menos do que cerca de um segundo. 

Figura 24 - Barra de Progresso do ImageJ. 
 

Fonte: Documentação oficial do Imagej. 

 

7.1.5 Imagens 

 

O ImageJ permite que várias imagens sejam exibidas na tela ao mesmo 

tempo. A janela ativa tem a sua barra de título realçada, como pode ser observado 

na Figura 26. Todas as operações serão realizadas nessa imagem. A ferramenta 

ImageJ suporta 8 bits, 16 bits e de 32 bits (reais) imagens em tons de cinza e 8-bit e 

32-bit imagens coloridas. Imagens de 8 bits e são representados usando inteiros 

sem sinal no intervalo de 0 a 255. As imagens de 16 bits usam inteiros sem sinal (de 

0 a 65535) e imagens em escala de cinza de 32 bits utilizam números de ponto 

flutuante. 

 
Figura 25 - Janela de Imagem. 

 
Fonte: Documentação oficial do Imagej. 

 

As imagens 16-bit e 32 bits com escala de cinza não são diretamente 

disponíveis em monitores de computador, que normalmente podem mostrar apenas 
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256 tons de cinza. Portanto, os dados são mapeados para 8 bits por janelamento. A 

janela define a gama de valores de cinza que são apresentados: valores abaixo da 

janela são feitas em preto, enquanto os valores acima da janela são brancos. A 

janela é definida por valores mínimos e máximos que podem ser modificados 

usando Image > Adjust > Brightness / Contrast. 

 

7.1.6 Stacks ou Pilhas 

 

A documentação oficial do ImageJ descreve que a ferramenta pode exibir 

várias imagens espaciais ou temporalmente relacionados em uma única janela. 

Estes conjuntos de imagens são chamados stacks ou pilhas. As imagens que 

compõem uma stack são chamadas slices. Todas as fatias de uma stack devem ser 

do mesmo tamanho e profundidade de bits. A barra de rolagem fornece a 

capacidade de mover-se através das fatias. A maioria dos filtros ImageJ irá, como 

uma opção, processar todas as fatias em uma stack. 

A ferramenta ImageJ abre arquivos TIFF multi-imagem como uma stack, e 

salva stacks como TIFF multi-imagem. O comando file > Import > Raw abre outra 

multi-imagem, os arquivos descompactados. File > Import > Sequence abre uma 

pasta de imagens como uma Stack. Para criar uma nova stack, escolha 

simplesmente File > New > Image e defina o campo "Slices" ou fatias para um valor 

maior do que um. O submenu Image > Stacks contém comandos para operações de 

stack comum. 

  

                             
Figura 26 - Exemplo de Stacks no MAC. 

 
                                       Fonte: Documentação oficial do Imagej. 
 

7.1.7 Selections ou Seleções 
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De acordo com a documentação oficial da ferramenta, as seleções são áreas 

definidas pelo usuário ou linhas dentro de uma imagem. Apenas uma seleção pode 

estar ativa de cada vez. Seleções da área são criadas usando as ferramentas de 

seleção retangulares, elípticas, poligonais e à mão livre, como é possível observar 

na Figura 29. Essas seleções podem ser medidas (Analyze > Measure), filtrada, 

preenchida (Edit > Fill) ou desenhada (Edit> Draw). Seleções de linha são criadas 

usando as ferramentas de seleção linha reta, segmentadas e à mão livre. Use Edit > 

Draw para desenhar a linha na cor atual. O comprimento da linha de seleções pode 

ser medido utilizando Analyze> Measure. 

 

                       
                       Figura 27 - Exemplos de Seleções Possíveis. 

 
                         Fonte: Documentação oficial do Imagej. 

  

As seleções podem ser movidas, clicando e arrastando. A barra de status 

exibe as coordenadas do canto superior esquerdo da seleção (ou o retângulo 

delimitador para as seleções não retangulares), uma vez que está sendo movido. 

Observe que o cursor se transforma em uma seta quando está dentro da seleção. 

Para mover o conteúdo de uma seleção retangular, em vez da própria seleção, Edit> 

Copy (c), Edit > Paste (v), e em seguida, clique dentro da seleção e arraste. Use as 

setas para deslocar seleções um pixel em um momento em qualquer direção. 

Como descrito na documentação do Imagej, seleções retangulares e elípticas 

podem ser redimensionadas. Como a seleção é de redimensionamento, a largura e 

altura são exibidas na barra de status. Use as setas do teclado com a tecla Alt para 

esticar seleções retangulares ou elípticas um pixel de cada vez. 

Para eliminar uma seleção, escolha qualquer uma das ferramentas de 

seleção e clique fora da seleção, ou utilizar a opção Edit > Selection> Select None 

(shift-a). Use Edit > Selction > Restore Selection (shift-e) para restaurar uma seleção 

de volta depois de ter removido a mesma. 

A seleção pode ser transferida de uma janela de imagem para outra, ativando 

a janela de destino e usando Edit > Selection > Restore Selection. As seleções 

podem ser salvas no disco usando File > Save As > Selection e restauradas usando 
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File > Open. Use o Gerenciador de ROI ou ROI Manager para trabalhar com várias 

seleções. 

 

7.1.8 Formato de Arquivos 

 

De acordo com a página oficial do Imagej, o comando File > Open abre TIFF, 

GIF, JPEG, PNG, DICOM, BMP, PNG e imagens FITS. Ele também abre tabelas de 

pesquisa e seleções. Além disso, o submenu File > Import fornece acesso a plugins 

para leitura de arquivos "raw", imagens em formato ASCII, e para carregar imagens 

através da rede utilizando uma URL. Para importar um arquivo raw, você deve saber 

algumas informações sobre o layout, incluindo o tamanho da imagem e o 

deslocamento para os dados da imagem. Os arquivos podem ser salvos em TIFF, 

GIF, JPEG, PNG, PGM, FITS, texto delimitado por tabulação e formatos RAW. 

Adicionar suporte para formatos adicionais ao fazer o download ou escrever plugins. 

O plugin Bio-Formats da Universidade de Wisconsin abre 69 diferentes formatos de 

arquivo de imagem de ciências da vida. 

 

7.1.9 Plugins 

 

  Segundo a documentação oficial do Imagej, a funcionalidade do ImageJ pode 

ser expandida através do uso de plugins escritos em Java. Plugins podem adicionar 

suporte para novos formatos de arquivos ou eles podem filtrar e analisar imagens. 

Plugins estão localizados na pasta ImageJ "plugins" e podem ser instalados 

automaticamente no menu Plugins ou eles podem ser instalados em outros menus 

usando Plugins / Hot Keys / Install Plugin. Eles podem ser criados ou modificados 

usando Plugins / Edit. Mais de 150 exemplos de plugins estão disponíveis para 

download no site da ImageJ. 

 

                                       Figura 28 - Tabela de Pesquisa. 

 
                                          Fonte: Documentação oficial do Imagej. 
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Imagens em tons de cinza são apresentados usando uma tabela de consulta 

de cores ilustrada na Figura 29, que descreve a cor a ser usada para cada um dos 

256 possíveis valores de pixel indicados. Selecione as paletas de cores alternativas 

a partir das tabelas submenu Image / Lookup Tables. Use Image / Adjust Brightness 

/ Contrast para melhorar as imagens, alterando de forma dinâmica o mapeamento 

tabela de pesquisa e Analyze / Show LUT para exibir a tabela de referência da 

imagem ativa. 

Um exemplo de um Plugin disponível na página do ImageJ é o “3D Color 

Inspector/Color Histogram” que executa a operação de mostrar a distribuição de 

cores dentro de espaço de cor 3D. A sua documentação está disponível em 

www.f4.fhtw-berlin.de/~barthel/ImageJ/ColorInspector/help.htm e a explicação de 

como deve ser instalado e outras informações em 

http://rsb.info.nih.gov/ij/plugins/color-inspector.html. Na Figura 30 é possível observar 

o funcionamento desse plugin exibindo um exemplo. 

 
Figura 29 - Exemplo de Plugin Disponível. 

Fonte: Documentação oficial do Imagej. 
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7.2 RECURSOS 

 

 A ferramenta ImageJ, como pode ser vista na Figura 32 pode exibir, editar, 

analisar, processar, guardar e cores de impressão de 8 bits, em tons de cinza, 16-

bits inteiros e 32-bits de ponto flutuante de imagens. Ela pode ler muitos formatos de 

imagem, incluindo TIFF, PNG, GIF, JPEG, BMP, DICOM, FITS, bem como formatos 

RAW. 

 Como descrito em sua documentação oficial, o ImageJ suporta pilhas de 

imagens, uma série de imagens que compartilham uma única janela, e ela é 

multithreaded, portanto, operações demoradas podem ser executadas em paralelo 

em hardware multi-CPU. Ele pode calcular a área e o valor de pixel, estatísticas de 

seleções definidas pelo usuário e objetos de intensidade thresholded. Pode também 

medir distâncias e ângulos, pode criar histogramas de densidade e gráficos de perfis 

de linha.  

Suporta funções de processamento de imagem padrão, como operações 

lógicas e aritméticas entre imagens, contraste manipulação, convolução, análise de 

Fourier, nitidez, suavização, detecção de borda e filtragem mediana. Ela faz 

transformações geométricas, como escala, rotação e flips. O programa suporta 

qualquer número de imagens simultaneamente, limitada apenas pela memória 

disponível. 

 
Figura 30 - Paleta de ferramentas do ImageJ. 

 
Fonte: Documentação oficial do Imagej. 

 

Como possível verificar na Figura 31, está organizada em oito menus:  

 FILE > As operações básicas de arquivo (abrir, salvar, criando novas 

imagens). A maioria são auto-explicativos. 

 EDIT >  Editing and drawing operations as well as global settings. 
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 IMAGE > Conversão e modificação de imagens, incluindo transformações 

geométricas. 

 PROCESS > Processamento de imagem, incluindo operações de ponto, filtros e 

operações aritméticas. 

 ANALYZE > Medidas estatísticas, perfil e histograma de plotagem e outras 

operações relacionadas com a análise de imagens. 

 PLUGINS > Os comandos para a criação, edição e gerenciamento de add-ons 

(consulte Estendendo ImageJ), listando todos os instalados pelo usuário 

Macros, Scripts e Plugins instalado no / plug-ins / diretório ImageJ. 

 WINDOWS > Seleção e gerenciamento de janelas abertas. 

 HELP > Atualizações, recursos de documentação e informações sobre a 

versão. 

A documentação ofocial da ferramenta descreve outros recursos da Ferramenta 

Imagej como: 

 Permite ser executado em todos os lugares, escrito em Java, que permite que 

seja utilizado no Linux, Mac OS X e Windows, em ambos os modos de 32 bits 

e de 64 bits.  

 Open Source, seu código fonte Java estão livremente disponíveis e são de 

domínio público, não sendo necessário nenhuma licença.  

 Possui uma comunidade de uiuários: grande e bem informada do usuário em 

todo o mundo sendo mais de 1700 usuários e desenvolvedores inscritos na 

lista de discussão ImageJ.  

 Macros ou tarefas automatizadas e criação de ferramentas personalizadas 

utilizando macros. Gerar código de macro com o gravador de comando e 

depurá-lo usando o depurador macro. Mais de 300 macros estão disponíveis 

no site do ImageJ.  

 Possui plug-ins sendo possível estender a ferramenta pelo desenvolvimento 

de usando a construção de um editor de texto do ImageJ e o compilador 

Java. Mais de 500 plugins estão disponíveis.  

 Toolkit, podendo usar o ImageJ como um kit de ferramentas de 

processamento de imagem (biblioteca de classes) para desenvolver applets, 

servlets ou aplicações.  
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 Velocidade sendo o programa mais rápido do mundo Java puro 

processamento de imagem. Ele pode filtrar uma imagem de 2048x2048 em 

0.1 segundos (*). Isso é 40 milhões de pixels por segundo!  

 Apresenta tipos de dados em tons de cinza de 8 bits ou de cores indexadas, 

16-bit inteiro sem sinal de 32 bits de ponto flutuante e de cor RGB.  

 Os formatos de arquivos suportados são GIF, JPEG, BMP, PNG, PGM, FITS 

e ASCII.  

 Exibição de imagem: As ferramentas são fornecidas para controlar o zoom 

(1:32 a 32: 1) e rolagem imagens. Todos análise e processamento de funções 

funcionam em qualquer fator de ampliação.  

 É possível criar seleções retangulares, elípticas ou irregulares da área. Criar 

linha e ponto de seleções. Edite seleções e automaticamente criá-las usando 

a ferramenta Wand. Draw, preencher, claro, filtro ou seleções de medida. 

Salvar seleções e transferi-las para outras imagens.  

 Aperfeiçoamento de Imagem, suportando alisamento, nitidez, detecção de 

bordas, filtragem mediana e limiar tanto em escala de cinza de 8 bits e RGB 

imagens coloridas. Interativamente ajustar o brilho e o contraste de 8, 16 e 

32-bit imagens.  

 Operações geométricas: Colheita, escala, redimensionar e girar. Virar 

verticalmente ou horizontalmente.  

 Análise: Área, média, desvio padrão, mínimo e máximo de seleção ou 

imagem inteira medida. Medir comprimentos e ângulos. Use unidades de 

medida do mundo real, como milímetros. Calibrar utilizando padrões de 

densidade. Gerar histogramas e gráficos de perfis.  

 Edição: Cortar, copiar ou colar imagens ou seleções. Cole usando AND, OR, 

XOR ou modos de "mistura". Adicione o texto, setas, retângulos, elipses ou 

polígonos de imagens.  

 Processamento de cores: Dividir uma imagem a cores de 32 bits em 

componentes RGB ou HSV. Mesclar componentes de 8 bits em uma imagem 

colorida. Converter uma imagem RGB para 8-bit de cores indexadas. Aplicar 

paletas de pseudo-cores para imagens em tons de cinza. 
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 Pilhas: Apresentar uma "pilha" de imagens relacionadas em uma única janela. 

Processar uma pilha inteira usando um único comando. Abra uma pasta de 

imagens como uma pilha. Salvar pilhas como arquivos TIFF multi-imagem. 
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8 METODOLOGIA 

 

 Como proposta para o projeto que foi desenvolvido, inicialmente foi realizada 

uma pesquisa acerca da teoria de processamento de imagens e do uso da 

tecnologia na medicina. Essa busca foi muito importante para definir a área de 

desenvolvimento dentro da vertente de medicina. 

Concluída a pesquisa, foi definido primeiramente a partir das necessidades do 

projeto, qual ferramenta seria utilizada. Mais especificamente qual software e 

linguagem seriam utilizados, fazendo assim uma pesquisa dessa ferramenta e 

estudando sua possível utilização. 

A partir do conhecimento adquirido da ferramenta ImageJ que foi a escolhida, 

e a sua implementação com a linguagem Java, foi necessário também o estudo das 

técnicas de processamento de imagens e o início de suas implementações no 

programa para verificar qual seriam as melhores para obtenção do resultado 

desejado ou uma melhor delimitação da enfermidade estudada. 

A utilização da ferramenta ImageJ é imprescindível, pois, além da vantagem 

de ser um software livre obtido gratuitamente, possui várias ferramentas para análise 

de imagens e até vídeos. Além disso em seu site oficial (http://imagej.nih.gov/ij/) 

estão disponibilizados diversos plugins para aprofundar o uso dessa ferramenta. 

Além disso, foram coletadas diversas imagens de ultrassom da internet que 

passaram por laudo médico feito pelo Dr. Abdel Hafid Farid. No caso contém 

imagens de ovários com a síndrome dos ovários policísticos. Foi necessário o uso 

de 20 imagens para realizar o processamento adequadamente verificando a eficácia 

e eficiência dessa ferramenta. 

Após todas as informações serem coletadas e o estudo feito, foi finalmente 

realizado o desenvolvimento da aplicação que antes de tudo foi necessário escolher 

as técnicas de processamento de imagens a serem utilizadas, que irão atender as 

necessidades da aplicação e executar o processamento adequadamente. 

Após o término do desenvolvimento, foram executados testes de 

desempenho, qualitativo e quantitativos. A partir desses testes foi possível verificar 

se a aplicação atende as necessidades e se retorna resultados satisfatórios de 

acordo com as imagens analisadas. 

 

 



56 
 

9 DESENVOLVIMENTO DA APLICAÇÃO 

 

Antes da aplicação ser implementada na linguagem Java, ou no NetBeans, foi 

necessário executar as técnicas de processamento anteriormente no próprio ImageJ 

para verificarmos quais serão inseridas diretamente no código do programa 

automatizado.  

 O imageJ propiciou uma forma mais rápida de verificação e obtenção dos 

resultados dessas técnicas a partir dos valores inseridos e da quantidade de 

técnicas diferentes e iguais utilizadas. 

 

 
                      Figura 31 - Ferramenta ImageJ ao adicionar Imagem de ovário original. 

 
                         Fonte: elaborado pelo autor. 
 

No caso da imagem 32, mostra o primeiro estágio do processamento onde a 

imagem é escolhida e se inicia o uso das técnicas. 

A Figura 33 mostra a próxima técnica utilizada chamada Subtract 

Background, utilizada para suavizar a parte do fundo da imagem fazendo com que a 

mesma não interfira no trabalho que será feito na parte que realmente importa dessa 

imagem. 

 Dessa forma torna mais fácil de se trabalhar apenas com a parte que 

realmente é importante no processamento, ou seja, os cistos em si. 
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 O valor escolhido para essa técnica foi o de 110.0 que após algumas 

tentativas, foi o valor que melhor atendeu as necessidades. Irá subtrair assim 

adequadamente a parte indesejada e o caminho para utilizá-la é Process > Subtract 

Background. 

                      Figura 32 - Resultado do Subtract Background. 

 
                      Fonte: elaborado pelo autor. 

 

A próxima técnica utilizada é a Threshold como pode ser observado na Figura 

32 e o valor escolhido de limitar T como separação dos tons de cinza foi 60 

utilizando a opção de preto e branco. Isso fará com que os cistos se destaquem com 

o uso dessa diferenciação das duas cores. 

O caminho para utilização é Image > Adjust > Threshold. 

                     Figura 33 - Utilização do Threshold. 

 
                       Fonte: elaborado pelo autor. 
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                        Figura 34 - Make Binary. 

 
              Fonte: elaborado pelo autor. 

 

 Para a utilização da próxima técnica é necessário tornar essa imagem binária 

como observado na Figura 35, ou seja, tornar os cistos na cor preta que é 

necessário para um preenchimento posterior descrito a seguir. 

 É possível de ser realizado em Process > Binary > Make Binary. 

                          Figura 35 - Fill Holes. 

 
                            Fonte: elaborado pelo autor. 

 

A técnica utilizada na Figura 36 é a Fill Holes que, como o próprio nome diz, 

irá completar os buracos ou espaços localizados dentro dos cistos, facilitando a 
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interpretação de que ele é um cisto completo. Podendo assim, discernir os dados 

utilizados na contagem final com mais facilidade. 

Ele se localiza em Process > Binary > Fill Holes. 

                 
                  Figura 36 - Resultado do processamento no ImageJ. 

 
                 Fonte: elaborado pelo autor. 

 

 Como ilustrado na Figura 35, para verificar o resultado dessas técnicas é 

necessário selecionar Analyse > Analyse Particles que fará a análise da imagem 

final, retornando à quantidade dos cistos, seus tamanhos e a localização com sua 

contagem. 

Essa imagem ilustra o passo final da utilização de todas as técnicas no 

ImageJ que foi o primeiro passo para o desenvolvimento, a escolha do que seria 

utilizado no software. 

A partir de todos os passos descritos anteriormente na ferramenta Imagej 

foram escolhidas as técnicas que seriam aplicadas diretamente no software 

NetBeans que foi utilizado nesse projeto. A Figura 36 mostra o que acontece quando 

o programa é compilado e após o usuário inserir a imagem que deseja processar.  

A imagem a seguir mostra o resultado da inserção de uma imagem do 

computador e o resultado retornado automaticamente. É possível escolher de que 

forma esse resultado será exibido utilizando a janela mostrada na Figura 37. No 

caso da próxima imagem, a escolha foi de contagem direta, recebendo apenas o 
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valor impresso abaixo da janela construída, junto da imagem original sendo 

comparada com a processada. 
 

                
                 Figura 37 - Resultado do processamento por count. 

 
                  Fonte: elaborado pelo autor. 

 

 É possível notar que embaixo da janela com a imagem carregada e a 

processada, uma mensagem de resultado é exibida: “Foram encontradas 9 

célula(s)”, ou seja, nesse caso o processamento funcionou corretamente. 
 

                                Figura 38 - Janela de escolha do resultado do processamento. 

 
                                          Fonte: elaborado pelo autor. 

 



61 
 

Caso seja desejável mostrar os pontos selecionados na imagem, é 

necessário selecionar o “Point Selection” que irá mostrar a imagem a seguir. 
 

                        Figura 39 - Resultado por Point Selection. 

 
                         Fonte: elaborado pelo autor. 
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10 TESTES 
 

 Após finalizar o desenvolvimento da aplicação, foram necessários diversos 

testes utilizando todas as imagens coletadas para verificar, de forma detalhada, sua 

eficácia e eficiência. 

 Partindo do princípio de eficaz como sendo algo que possui qualidade, foi 

necessária uma verificação da quantidade dessas imagens que realmente trouxeram 

o resultado esperado, a porcentagem e no final de todos os testes, foi observado 

que 98% das imagens processadas trouxeram sucesso. Ou seja, apenas uma 

imagem das vinte coletadas não obteve o resultado almejado.  

 Foi realizada a verificação de sua eficiência também, ou seja, se executa a 

tarefa que é esperada e, seguindo o passo a passo adequado desse 

processamento, atendeu de fato o projetado. 
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11 RESULTADOS 
 

 De acordo com a premissa que de todas as vinte imagens processadas 19 

funcionaram corretamente é possível notar que a aplicação desenvolvida trouxe boa parte 

resultados satisfatórios. 

 Com o passo a passo de cada técnica de processamento realizada era possível 

notar que os nódulos ficavam cada vez mais nítidos e visíveis, facilitando sua identificação.  

Além disso, é possível observar que os valores retornados podem ser exibidos de diversas 

formas, inclusive detalhando o tamanho de cada cisto e isso é um ponto interessante a ser 

ressaltado pois podemos observar a identificação da presença dessa enfermidade de 

diversas formas e aspectos. 
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12 CONSIDERAÇÕES FINAIS 

 

O presente trabalho apresentou os passos no desenvolvimento de uma 

aplicação que utiliza técnicas de processamento de imagens implementadas com a 

ferramenta ImageJ para detectar cistos em ovários, podendo assim retornar ao 

médico o resultado se a paciente possui ou não a doença do ovário policístico. 

Após realizar o desenvolvimento dessa aplicação foi possível concluir que o 

processamento de imagens é uma área que tem muito a ser explorada para auxiliar 

diversos diagnósticos na medicina entre outras áreas, trazendo inúmeros benefícios 

a área da saúde. 

Além disso, ao se desenvolver esse processamento foi necessário a utilização de 

outra área informatizada que já auxilia a medicina a um tempo, as imagens 

ultrassonográficas. 

Outro fator a ser destacado é que foi necessário um estudo mais aprofundado 

das técnicas de processamento e testes de cada uma delas para verificar quais iriam 

auxiliar e trazer um resultado satisfatório para esse processamento. 

O caminho para se desenvolver posteriormente no NetBeans foi a escolha 

das técnicas na própria palheta da ferramenta ImageJ, isso foi imprescindível para 

que as técnicas fossem escolhidas corretamente. 

 Após a realização da aplicação foram testadas todas as imagens coletadas 

da enfermidade e chegou-se à conclusão de que todas elas atenderam os 

esperados resultados, ou seja, o mesmo resultado diagnosticado pelo médico a olho 

nú. 

Embora a ferramenta construída ofereça inúmeros benefícios, ela não 

substitui o atendimento feito por profissional especializado, por esse motivo, essa 

tecnologia deve ser empregada apenas para que o diagnóstico feito pelo médico 

seja mais rápido visto que o mesmo recebe várias imagens diariamente para serem 

analisadas. 
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